Writing for SQA
(A to Z version)

About this guide
Writing for SQA is for everyone in the organisation. Whether you are writing a
letter, a report, an assessment item, or a promotional e-mail — this guide is for
you.
The topics in the list on the next page are hyperlinks to explanations and
examples that we hope you will find helpful. Most of the topics are no more than
half a page in length but some extend to a few pages.
If you are new to SQA or are using Writing for SQA for the first time, we
recommend that you start with:
 Writing the name of the organisation
 Referring to SQA’s qualifications
 Plain English
Previous readers will find new content in:
 Capital letters
 Copyright
 E-mail
 Web pages
If you have any questions, please e-mail marketing@sqa.org.uk or contact one of
SQA’s editors.
[Go to A to Z content ...]
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A or an?
Be guided by pronunciation. Use ‘a’ before words beginning with ‘h’, unless the
‘h’ is silent:
 a history, a hope, a Higher pass, a hotel
 an hour, an heir, an honours degree

Before abbreviations
Where the letters are sounded as letters, use ‘an’ before A, E, F, H, I, L, M, N, O,
R, S, and X:
 an SVQ, an HND
 a PDA
[Back]
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Abbreviations and acronyms
When giving a name that is normally abbreviated to its initials, or an acronym,
give it in full the first time you use it, followed by the abbreviated form in
parentheses. For example:
‘Highlands and Islands Enterprise (HIE) is responsible for economic regeneration
in that region. HIE’s role also extends to …’
Note: an acronym is formed from initials and pronounced as a word, eg scuba
(self-contained underwater breathing apparatus) or NATO (North Atlantic Treaty
Organization).

Full stops
Full stops mark the ends of sentences. We do not use them in abbreviations or
acronyms:
 BBC, IBM, HIE, UHI, Mr Blair, Dr Foster
See Eg, ie, etc for more on abbreviations.
[Back]
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Accessibility
All SQA communications, publications and everything else we write should be
accessible to everyone, and should reflect an inclusive view of society. Any
examples, tasks, images, and language used should mirror this view.
Check your text for any cultural references. SQA’s materials are increasingly
used by people whose first language is not English.

Use plain English
Almost all disability rights groups stress the importance of using language that is
easy to understand.
Never use ‘click here’. In fact, the word ‘click’ should be avoided in general, as it
assumes the reader is using a mouse to navigate the site. The same goes for
phrases like ‘use the box on the right’ — screen readers and some specially
configured browsing agents do not present content in columns, so the statement
would not make sense to the person reading or hearing it.
More on plain English
What is a screen reader?

Use Word styles
Use the ‘Styles’ function to apply heading styles in Microsoft Word. This will make
the text accessible to someone using a screen reader.
How to use Word styles
To create accessible Word and PDF documents — see Appendix 1 of SQA’s
Web Content Guidelines

Pictures
Only use diagrams and photographs that complement the written text. Try not to
rely solely on pictures to explain a particular point — someone using a screen
reader could be disadvantaged. Any images must be given a visual description
as alternative text. (Use ‘Format picture’, select the ‘Web’ tab, and enter the
description in the ‘Alternative text’ field.)
Images should not be used exclusively as a navigation device or to convey
information. If images are used, a text equivalent should also be provided.

Offer alternatives
Can you envisage any barriers that might restrict a task or activity from being
carried out? For example, a task asking an IT candidate to use a mouse to carry
out an action will cause problems for someone with motor difficulties. Give
alternative ways to carry out the task such as using the keyboard.
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SQA can produce material on request in audio, braille and other alternative
formats for disabled customers, including those with learning difficulties.
Promoting equality is something SQA takes very seriously.
SQA’s equality home page

Guidelines for web accessibility
SQA’s website, and all our web services, follow the W3 Consortium guidelines for
web accessibility, aiming for ‘AA’ standard.
More information is available on their website (www.w3.org).
There is also a quick reference guide (www.w3.org/WAI/WCAG20/quickref/).
See also the Web Team community on Connections for more on web
accessibility.
[Back]
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Apostrophes
Apostrophes have two functions:
 They indicate possession, as in:
‘Overall, candidates’ results in this subject show much improvement.’
 They show that a letter (or more than one) has been missed out, as in:
‘I very much regret that I didn’t respond to your letter.’
Apostrophes are never used to show that a noun is plural (this is known as the
greengrocer’s apostrophe, as in:
 apple’s and pear’s 45p, or
 room’s 24 and 25
The plural form of SVQ is SVQs, not SVQ’s.

Difficult apostrophes
These are the rules on when to use ’s [apostrophe s] and when to use
s’ [s apostrophe] in cases which can cause confusion:
Singular words which end in the letter s take ’s [apostrophe s] in the possessive:
 this chair is my boss’s
 James’s wombat
 the princess’s didgeridoo
Their plurals take s’ [s apostrophe]:
 bosses’ cars
 princesses’ privileges
Plurals which don’t end in s take ’s [apostrophe s] in the possessive:
 children’s books
 sheep’s clothing
It’s very difficult, especially when you’re in a hurry, to get all of your its and it’s
right. Use its when you mean the possessive and use it’s when you mean ‘it is’.
 Every dog has its day.
 It’s a disaster!

No apostrophe
There is no apostrophe in the name of a decade:
 the 1980s not the 1980’s
[Back]

8

Appendices
An appendix is a useful home for something which you think is helpful to
understanding your text, but for which there is no room inside the text. It might,
for instance, take up too much room, or it might disrupt the flow of what you are
saying if you were to put it in the body of the text.
However, appendices have their disadvantages.
First, if your readers need to read the information in an appendix before they can
understand what you are saying, they will find themselves flicking backwards and
forwards between the appendix and the text. You should avoid this at all costs.
On the other hand, if they don’t need to have the information that is in the
appendix, they may well ignore it altogether.
The question you should ask yourself before adding an appendix to your
document is whether what you are proposing is really so important. After all, if it
were that important, you would want to put it in the main body of the text.
The sorts of thing you might want to put in an appendix include:






health and safety requirements
a list of legislation which has a bearing on what you have said
statistics, included for the reader’s interest
a list of other publications to read
forms that your readers might need to copy and use (though worked
examples are, as a rule, better included with the text)

Appendices do have a role, but they can be overused. Exercise caution if you’re
considering adding an appendix to your document.
[Back]
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Bullets
Bullet point lists are:
 easy to read
 visually striking
 clean and neat

To capitalise or not to capitalise …
Bullet points should not be capitalised when they are incomplete sentences that
cannot be read on their own without the stem (as in the example above). In this
case, they should not finish with commas or semicolons.
Bullets should be capitalised, and end with full stops, when the text forms a
complete sentence that can exist on its own. For example:
‘There are numerous benefits of using bullet points:
 They are useful for lists, allowing the reader to determine the main points
easily.
 They break up long sections of text. This will help improve the readability of
the document.’

Grammatical sense
A list of bullets should also make grammatical sense: decide whether the bulleted
text should continue your original sentence or start a new one, and stick with your
decision.
For example, here’s how the bullets at the top of this section should not look:
‘Bullet points are:
 easy to read
 they are striking, visually
 bullet points are clean and neat’
Having said all this, you also have to be wary of overusing bullets, as too many
bullet points make a text hard to read. If you have more than three separate sets
of bullets on a page (ie bullets in more than three paragraphs) it may be time for
a rethink.
[Back]
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Can or may?
If you want to say that it is possible for candidates to be assessed by
examination, don’t say ‘candidates may be assessed by examination’ unless
you’re giving people permission (which implies to the reader that you are in a
position of authority and superiority). ‘May’ can also express a vague possibility,
as in ‘it may rain this afternoon, or it may not’.
‘Can’ expresses simple capability, and is almost always the word you want. So:
 candidates can be assessed by examination
 publications can be ordered from our Customer Contact Centre
 the school liaison officer can be contacted on …
[Back]
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Capital letters
SQA’s rule for when to use capitals, and when not, is:
 if it is the title of a specific person or thing, it takes title case
 if it’s a more general name, it doesn’t
Title case means initial capitals on main words only; sentence case means an
initial cap on the first word; and lower case means no capitals at all. Most of the
time, we will use lower case.
As well as words that take capitals in everyday English (such as the names of
people and places), things that always need capitals when we’re writing for SQA
are:





names of qualifications
unit and course titles
the name of the subject of an SQA qualification we’re discussing; and
publication titles (but not types of publication)

Capitals are useful as signposts, and to help distinguish between different kinds
of thing (eg the subject History taught in school, the history of the school, for
instance). Don’t use them, though, in an attempt to add weight or authority to
what you’re saying, or because a word seems important.
See SQA’s Guide to Using Capital Letters on Connections for detailed guidance
and examples.
[Back]
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Colons and semi-colons
There are two uses for a colon. The first is to introduce a list of things: group
awards, courses, units, and performance criteria, for instance. The second is to
link two phrases of equal weight in one sentence, where there is an idea of
progression: as there is here. You can also use a dash in these circumstances.
Semi-colons are used to distinguish between the items in a list where it would be
confusing to do so by using simple commas, as in this example:
‘SQA works in partnership with education, business and government to ensure
that its qualifications are: relevant to the needs of students and employers;
flexible enough to adapt to changing economic circumstances and technological
change; and recognised throughout the UK, Europe, and beyond.’
If you find yourself using a sentence like this, though, it would almost always be
better to try to use a list of bullets instead.
Don’t use a colon followed by a hyphen ( :- ).
[Back]
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Commas
Commas are important. They’re used in two ways: to separate clauses in
sentences, and to separate small items in lists.

Clauses
If you think of what you’re writing as speech, you can think of commas as the
places where you’d pause (as you would after ‘speech’ in this sentence). If you’re
unsure about whether to insert a comma or not, try reading your sentence aloud.
The places where you pause are almost always crying out for a comma. If you’re
still unsure, insert a comma anyway.
Using commas really helps people to understand what you’re saying, because it
breaks your statements down into bite-sized chunks. Here’s a moderately
complex sentence with no commas:
‘Interim reviews throughout the year will follow the same pattern as your annual
review and will concentrate on your progress against agreed objectives noting
any changes in objectives and progress towards achievement of your personal
development plan.’
It’s particularly confusing around the ‘objectives noting’ area. Here it is broken
down into chunks, and much easier on the reader’s eye and brain:
‘Interim reviews throughout the year will follow the same pattern as your annual
review, and will concentrate on your progress against agreed objectives, noting
any changes in objectives and progress towards achievement of your personal
development plan.’

Lists
We use what is known to editors as ‘full Oxford stopping’ in lists, because lists
(especially the lists we use) can get so complicated. The rule is that all the items
are separated by commas (or by semi-colons if the items are large) even those
final items preceded by ‘and’. Here’s an example:
‘Engineering, Personal and Interpersonal Skills, Communication, Art and Design,
and Information Technology.’
Given that our lists get even more complicated than this, it is best to be as
rigorous as possible in marking off one item from another, and the way to do this
is by using commas.
If your list contains items that are more than a few words long, though, use semicolons.
[Back]
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Contents list
There’s no need to provide a contents list if you are sending a document to be
edited. The editor will generate the contents list automatically using Word once
the document has been edited and formatted.
[Back]
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Copyright
Please see SQA’s copyright and permissions page on Connections — especially
the separate file called SQA’s Copyright Guidelines (2014), but note that the law
now also includes the following exception on quotations:

Quotations
Copyright law has changed to give people greater freedom to quote the works of
others. You will not need to seek the permission of the copyright owner as long
as the quotation is accompanied by a sufficient acknowledgement — which
generally means the title and the author’s name should be indicated, and as long
as the use is considered reasonable and fair (‘fair dealing’). This is an
extension to the existing law that already allows fair dealing with copyright
materials for the purpose of criticism, review and news reporting.
Will this mean people can ‘quote’ any amount of copyright material without
permission? No. The change only allows use of material where it is genuinely for
the purpose of quotation, and only where the use is fair and reasonable (eg it
does not replace a commercial sale). So, for example, it could permit a short
quotation that is necessary and relevant in an academic paper or a history book,
but it would not permit a long extract.
Does this apply to photographs? Whilst the exception applies to all types of
copyright work, it would only be in exceptional circumstances that copying a
photograph would be allowed under this exception. It would not be considered
fair dealing if the proposed use of a copyright work would conflict with the
copyright owner’s normal exploitation of their work. For example, the ability to sell
or license copies of photographs for inclusion in newspapers would be a normal
exploitation.

What is fair dealing?
'Fair dealing’ is a legal term used to establish whether a use of copyright material
is lawful or whether it infringes copyright. There is no statutory definition of fair
dealing — it will always be a matter of fact, degree and impression in each case.
The question to be asked is: how would a fair-minded and honest person have
dealt with the work?
Factors that have been identified by the courts as relevant in determining whether
a particular dealing with a work is fair, include:
 Does using the work affect the market for the original work? If a use of a work
acts as a substitute for it, causing the owner to lose revenue, then it is not
likely to be fair.
 Is the amount of the work taken reasonable and appropriate? Was it
necessary to use the amount that was taken? Usually only part of a work may
be used.
The relative importance of any one factor will vary according to the case in hand
and the type of dealing in question.
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Source: Intellectual Property Office Online (2014) Exceptions to copyright:
Guidance for creators and copyright owners www.gov.uk/ipo
Note: If you use copyright material and make it available to anyone (eg by putting
it on a public website) then it is not likely to be viewed as fair dealing.

Contacts for copyright queries and advice
Question papers: Michael Gallagher and Janine Anderson, Assessment
Development and Delivery
Support materials: Melanie Beck and Maggie Quinn, Assessment Development
and Delivery
Corporate and marketing: David McCormick, Marketing
[Back]
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Cross-references
When you’re referring to another publication in what you’re writing, give the title of
that publication in italics, like this:
‘You will also find a very useful and detailed explanation of the various
instruments of assessment you can use in the Guide to Assessment and Quality
Assurance.’
When you’re referring to another section in your own publication, or to a section
of another publication, give the name of the section in quotation marks, like this:
‘You will also find a very useful and detailed explanation of the various
instruments of assessment you can use in the Guide to Assessment,
‘Assessment instruments’.’
[Back]
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Dashes
Dashes have two similar uses:
 You can put an explanatory phrase — like this one — in long dashes in the
middle of a sentence. You can’t, though, use more than one pair of dashes
per sentence. You can use brackets instead of dashes.
 You can link two equally important phrases with a long dash where you don’t
want to start a new sentence — much as you might use a colon. It is better to
use a long dash than a colon in these circumstances.
The keyboard shortcut for a long dash is alt 0151.
See Range of years and Numbers for when to use a short dash (alt 0150).
If your text is intended purely for a web page, then just use a hyphen — older
browsers can sometimes have difficulty rendering any other type of dash.

[Back]
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Dates and time
Dates should not be punctuated. Our preferred style for dates is day month year:
1 June 2011. The easy way to remember this is to remember that the units of
time start small (1) on the left, and end up big (2011) on the right.
Ensure dates appear in one line and are not separated by a line break. For
example, writing 1 June 2011 would be fine, whereas writing something like 1
June 2011 wouldn’t.
The preferred style for times is the twelve-hour clock with ‘am’ or ‘pm’. Give the
value in figures separated by a stop and with a space before ‘am’ or ‘pm’, as in
these examples:
‘I suggest we meet at my office at 12.30 pm on 23 May. Please let me know
whether this is suitable.
If it is not suitable, I’ll also be available on 26 May after 2 pm.’

Range of years
If you have to give a range of years (for instance if you’re talking about an
academic session), use a short dash, and miss out the first two characters if
they’re the same in both dates. So, 2007–08, but 1997–2007. Alternatively, you
can write it out in full: from 1997 to 2007, but you mustn’t mix the two methods
(from 1997–2007).
The keyboard short cut for a short dash is alt 0150 (with Num Lock switched on).

Seasons of the year
There’s no need to give an initial capital to the names of the seasons — spring,
summer, autumn or winter — unless they are occurring as part of the proper
name of something, eg Summer Lightning, The Lion in Winter. In ordinary use,
lower case is better, eg ‘let’s discuss this again in the spring’.
[Back]
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Diagrams, maps and graphs (line illustrations)
If your document includes graphics which need to be drawn by an artist, please
provide a clear drawing of each illustration on a separate sheet of A4. The
drawings can be basic but should include all the features that you want to appear
in the final illustration.
SQA’s graphic artists are professionals, but they may not be specialists in your
subject. Please therefore annotate your drawings with descriptions and
instructions to help them as much as possible, circling any text that is not meant
to appear in the final illustration as a label. Remember to number each drawing
and indicate its position in the text.
If you wish to supply a photocopy as an artist’s reference, please indicate that it is
to be used as a reference only. Also, please provide directions to the artist as to
how the SQA illustration and labels should be amended to avoid infringing
copyright.
If you have the skills to use a drawing program such as Illustrator, please contact
the Communications team before you start work to agree file formats and to
arrange a trial run. We need to be sure that we can open and work with your
completed drawings.
Illustrations can be expensive and time-consuming to prepare. Please try to
ensure that any you request contribute to your publication and are not simply
‘filler art’.
When supplying an image for use on web pages you must also include suitable
text for visually impaired users — this should be a short visual description of the
image which will be used to describe how the image appears to screen readers
and other assistive software.
[Back]
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eg, ie, etc
The abbreviation which shows that you are giving an example is:
eg (not e.g. or eg.)
The abbreviation for ‘that is’ is:
ie (not i.e. or ie.)
Both ‘eg’ and ‘ie’, if you choose to use them, should follow a dash — eg like this
— or a comma, ie like this, or should be in a bracket.
When you want an abbreviation for ‘and so on’, you should write
etc (not &c. or etc.)
You should, though, use ‘etc’ with caution — don’t just put one in to be on the
safe side, or when you can’t think of anything else to go in the list, etc. Have a
real reason for it.
You must also avoid using more than one of these abbreviations in any clause —
you should never write:
eg English, French, German, Gaelic, etc
Write:
English, French, German, Gaelic, etc
or:
eg English, French, German, Gaelic
[Back]
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Elision (you’re, we’re, here’s, etc)
Elision or contractions are perfectly appropriate in most circumstances: in
newsletters, anything labelled as ‘guidance’, and anything addressed to teachers,
lecturers, people in the workplace, or candidates. It’s perhaps less appropriate in
procedural documents, or course and unit specifications — documents that have
an almost legal tone — but these are the exception rather than the rule.
Don’t feel that you can’t use ‘don’t’ or ‘can’t’ or ‘you’re’, and if it helps you to write
in a more natural style (because it’s closer to the way you speak), use it. It is
always better, when you’re writing a first draft, to be too informal than to be too
formal. Informality is an aid to clarity.
[Back]

23

Ellipsis …
The mark we use for ellipsis (which you should use when you want to show that a
chunk of text has been left out of a passage you are quoting) is three points …
like this. Here’s an example:
‘The mark we use for ellipsis … is three points’ (alt ctrl <full stop>).
There is always a space before the ellipsis character, except when it comes at
the beginning of a quoted sentence.
[Back]
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E-mail
It’s easy to reach for the keyboard to bash out an e-mail, but there are times
when this can cause an adverse reaction — especially if the personal touch
would have been better. Maybe a phone call would be a better way to sort out a
problem? Perhaps the other person would simply feel better (about us) if you took
the trouble to speak to them in person? On the other hand, e-mail is informal —
perhaps a letter would be better if a more formal response is called for.
If an e-mail is the right way for us to be communicating (and it often is), try to
keep in mind the following four points and you will produce a professional
communication that is readily understood and that supports SQA’s business
goals.
 Talk to your reader
 Keep it clear
 Be positive
 Look professional

Talk to your reader
There’s sometimes a tendency for the tone of business writing to be pitched in
remote and formal language, but there is really no need for this to be so. Use
natural, everyday language and avoid being overly formal. As a guideline, bear
this in mind:
If it’s something you wouldn’t consider saying in speech to your reader,
then don’t write it down.
This includes the salutation:
 If there is a need to be formal (eg if you are writing to a customer or a
member of the public) and you know the name of the person you are writing
to then you should say ‘Dear Mr/Ms/Mrs Surname’.
 If you know the person and have an established working relationship with
them you might say ‘Hi First name’ or just ‘Hello’.
 But what if you are writing to individual and you don’t know their name, or you
are writing an e-mail that will be sent to a large audience? You then have a
choice of ‘Dear Colleague’, ‘Dear Job title’, or as a last resort — ‘Dear
Sir/Madam’.
Many of our e-mails are written to people in centres who are doing the organising
and administration which running our qualifications demands. Once you’ve made
this plain in the subject line of your e-mail, there is no reason why you shouldn’t
then address these people as ‘you’ throughout the text, rather than referring to
‘centres’.
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So, make life easier for your readers. Rather than saying ‘Centres should retain
candidates’ work for verification’; say ‘You should retain candidates’ work for
verification’.

Keeping it clear
If there is one basic principle for writing clearly, it is this: keep it short and simple.
This applies to words, sentences and paragraphs.
Say what you want to say in as few words as you can and don’t be vague. For
example, say ‘We advise ...’, not ‘We would advise …’.
Prefer active verbs over passive verbs. For example, in ‘Lesley drafted the email.’ the verb ‘drafted’ is active, while in ‘The e-mail was drafted by Lesley.’ it is
passive.
There are, of course, some things that are better expressed as passives. You can
use the passive voice to avoid placing blame or to soften a statement. For
example:
‘…the invoice for this event has not been paid’ may produce a more positive reply
than ‘…you didn’t pay our invoice’.
But passives do de-personalise text and make it seem very remote from the
reader. The more passives there are in a text, the more this is reinforced. The
effect this has is to give readers the impression that we are bureaucratic and
distant (which is not the way we are at all). So, when you are, for instance,
explaining our policy, don’t say ‘it has been decided’, say ‘we have decided’.
If you’re giving advice, don’t say ‘it is recommended ...’, say ‘we recommend ...’.
Similarly, avoid constructions like ‘centres are advised …’.

Be positive
Our strapline is ‘It can be done’ so focus on what we will do, rather than what we
can’t or won’t. Also, don’t be afraid to apologise if we have made a mistake — but
say what we’re doing to put it right. For example, rather than saying ‘We cannot
provide the information you requested until next month’, it is better to say ‘We will
provide the information you requested by 28 February’.
Use co-operative vocabulary like ‘help’ and ‘work with’ to show that we work as a
team.

Look professional
Although they’re less formal than many other forms of writing, it’s still important
that e-mails that come from SQA look as professional as possible. This means
checking for easily-avoidable errors — factual errors, of course, but also spelling

26

mistakes and grammatical errors. Turn on the spellchecker (and leave it on).
Then check your message over. If possible, get someone else to read it before it
goes out, or leave a few minutes between writing and sending.
You should also probably keep the jokes to a minimum, unless you know the
recipient very well.
There are other aspects to looking professional. For instance, you can make
messages look as neat and business-like as possible and set up a signature that
will appear at the foot of every e-mail that you send. In Lotus Notes, go to File >
Preferences > Mail > Signature and insert:
‘Your first and second name’
‘Your job title’
‘Your SQA Office address and postcode’
‘Your direct line phone number’
If you're communicating with a group of stakeholders or customers you could
consider using SQA’s e-mail marketing system, which is used for our weekly
Centre News update to centres and for bulk e-mails to customers. Find out more
on Connections.

Finally
Signing-off
If you were writing a letter and you had opened it with ‘Dear Sir/Madam’ the
traditional sign-off would be ‘Yours faithfully’ but is there any need to use such an
archaic term in an e-mail? Well, as always, it depends on who you are writing to,
but in most business e-mails you can probably drop it altogether. However, don’t
just finish your message without some form of sign-off. Try to say something that
reflects the content of your e-mail, but if that is not feasible, you could try …
‘Thank you’ or ‘Regards’ or ‘Hope you find this helpful’
PS — you can use a ‘post script’ if you want to draw attention to something that
you’ve already mentioned or to provide further information.

More
The Essential Guide to Crafting a Work Email (Harvard Business Review)

[Back]
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Emphasis
Keep emphasis to a minimum or you won’t be able to see the wood for the trees.
If you want to emphasise text in a professional document — use bold. You can
also use bold to highlight new terms in learning and teaching materials. Don’t use
underlining to emphasise text, as screen readers won’t be able to read it, and use
italic for titles of units and publications (see Capital letters).
Don’t use italic if you are writing web page text — italic text is harder to read on
screen.
[Back]
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Footnotes
Avoid giving footnotes in any piece of writing which is for public consumption.
Footnotes can appear intimidating, so it is better to give whatever information it is
that you want to convey in the body of your text.
If you have to use a footnote, go to the References tab in Word and select Insert
Footnote.

[Back]
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Foreign words
Try to avoid using words from other languages that haven’t been fully naturalised
into English, because they make it hard for people who don’t know the language
in question to understand.
If you must use, say, a Latin word, assume that it has been fully adopted into
English, and treat it as an English word, if possible. The only exceptions to this
general rule are some scientific and mathematical terminology; and Latin words
ending in ‘-a’, which tend to take ‘-ae’ plurals.

Specific foreign words and their plurals
The plural of ‘forum’ is ‘forums’ (unless you’re writing about ancient Roman town
planning features).
The plural of ‘consortium’ is ‘consortiums’. (People do use ‘consortia’, but often
incorrectly, giving rise to ‘consortia-developed Higher National Qualifications’,
which is logically impossible.)
‘Syllabus’ causes enormous confusion. There’s no evidence for ‘syllabus’ actually
being a Latin word (it doesn’t look like a Latin word), or a Greek word, so we can’t
begin to tell what its classical plural might have been. In English, it’s always
‘syllabuses’ in the plural.
It’s perfectly acceptable in modern English to use ‘data’ as a singular (‘the data
shows us that uptake is increasing …’). It’s very strange to see its Latin singular
(datum) used outwith scientific journals, and unusual to see ‘data’ being used as
a plural — except in Computing texts.
[Back]
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Google Images
Many writers find Google Images to be a useful source of photographs. However,
even where an image is identified as free for educational use, it does not mean
that it can be published without permission.
All images are protected by copyright although some may have a Creative
Commons licence that does not require you to seek permission to use them.
Where images on Google Images do not have a Creative Commons licence, it
usually proves impossible to obtain permission to use them, because either the
copyright owners are hard to trace or they don’t reply to e-mails.
Rather than using Google, we recommend using a stock photography site that
SQA has an arrangement with, eg Shutterstock.
Note: there are different accounts in use across the organisation. Speak to
Procurement to find out if your business area already has an account.
[Back]
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Grammar myths
Myth: You musn’t use prepositions at the end of sentences
Prepositions relate nouns or pronouns to the rest of a sentence and include
words like ‘with’, ‘on’ and ‘at’. So, traditionally, putting them at the end of a
sentence was frowned on. However, this inspired the following quote from
Winston Churchill:
‘From now on, ending a sentence with a preposition is something up with which I
shall not put.’
If a preposition is going to fall at the end of a sentence naturally, let it stay there.
Go on. It happens naturally in English, and is something we should all be
perfectly comfortable with.

Myth: You musn’t use split infinitives
There aren’t actually any infinitives in English — instead we have a form
consisting of ‘to’ with the verb stem — so it follows that you can’t really split an
infinitive. You may be uncomfortable, though, with the idea of putting something
between your ‘to’ and your verb stem, but don’t go out of your way to avoid it,
especially when you’re saying something like ‘to fully appreciate’, or ‘to
completely understand’.

Myth: You must always use ‘you and I’
There’s no rule that says you always have to say ‘you and I’ — it’s often ‘you and
me’.
If you’d say ‘me’ when there was no ‘you and’, say ‘you and me’: ‘According to
you and me, done by you and me, arranged for you and me’.
If you’d say ‘I’ when there was no ‘you and’, say ‘I’: ‘You and I should meet, you
and I know, you and I are too old for this’.

Myth: Every ‘if’ requires a ‘then’
It’s not necessary to introduce the complement of every conditional with a ‘then’.
The meaning is usually quite plain from the context, and saying ‘then’ can
actually confuse people, who might read ‘then’ as a reference to a time. For
instance, ‘If you worry about tomorrow, you won’t sleep’ is perfectly
straightforward. ‘If you worry about tomorrow, then you won’t sleep’ introduces an
unnecessary ambiguity, because you can read it as saying ‘you won’t sleep
tomorrow if you worry about tomorrow’.

Use of shall
It’s not necessary to use ‘shall’ for the first person (I and we) future. Use ‘will’.
Indeed, it’s not necessary to use ‘shall’ at all — it sounds a bit pompous or
portentous — and its use is declining rapidly.
[Back]
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Hyphens
There is no consistent rule on when to hyphen and when not, but a general
principle is that two words should be hyphened if:
 they are more closely related to each other than to the other words in the
sentence
 it is more confusing not to hyphen them
Consider the phrase ‘temporary evidence record’. Without hyphens it is unclear
whether it is the evidence that is temporary or the record — if the latter sense is
meant, then ‘temporary evidence-record’ would be clearer. Note, though, that it
would be better still to recast the phrase, for instance as ‘temporary record of
evidence’ (see Nouns as adjectives).
Always hyphen these terms:








centre-devised
work-based
candidate-centred
part-time (and full-time)
project-based
nationally-recognised
vocationally-focused

Always use a hyphen before ‘oriented’ and ‘based’ when they are being used in a
compound — eg ‘people-oriented approach’ or ‘work-based learning’.
The prefix ‘re-’ usually takes a hyphen before a vowel: re-assess, re-establish, reevaluate, re-examine, re-open, re-order, re-organise, re-use (all hyphened).
If you’re using ‘e’ for ‘electronic’, always give it a hyphen. Many people use
‘email’, but if we don’t use the hyphen it gets very confusing when we talk about
‘eenabling eassessment in egovernment and ebusinesses’.
Treat ‘e-’ words as you would any other — capitalise the ‘e’ at the beginning of a
sentence (ie don’t say ‘e-Mail is a great way to communicate…’).
‘Pre-’ takes a hyphen before a vowel: pre-arrange, pre-existing, pre-ordained.
‘Co-’ takes a hyphen before an ‘o’: co-operate, co-ordinate (unless you’re talking
about coopers or chicken coops).
Words that have the -ise ending (to rhyme with ‘eyes’) are spelled with an ‘s’
(recognise, customise, advertise, homogenise), not with a ‘z’. Make sure you
have spelling set to English (UK), rather than English (US), so that Word doesn’t
try to correct any -ise endings.
[Back]
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Its or it’s?
The difference between its and it’s is that its is possessive, and it’s is a short
form of it is.
 The one thing about Scotland I don’t like is its weather.
 Oh look, it’s raining again.
Beware of situations where these two are easily confused:
 The great thing about the SVQ is its adaptability.
 The great thing about the SVQ is that it’s adaptable.
[Back]

34

Jargon
Highly specialised language with many technical terms is not always easy to
avoid, but there are steps you can take to minimise the bafflement readers feel.
There may be other words for ‘articulate’ (in the specialised sense in which we
use it) and for ‘implementation’. Please try to find alternatives.
We also have a tendency to say things like ‘the entering of candidates for
examinations’ when we could just as easily say ‘entering candidates for
examinations’. Avoid this sort of construction, because it can seem pompous and
mystifying.

Don’t write

Write

the recording of evidence
the entering of candidates
the implementation of SQA qualifications
the use of

recording evidence
entering candidates
implementing SQA qualifications
using

Plain English Campaign’s ‘A to Z of alternative words’

[Back]
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Mathematics
SQA’s editors use MathType to set equations in Microsoft Word.
If you don’t have access to MathType, please don’t try to emulate complicated
layouts in Word using the tab key and the space bar. Use brackets to indicate the
structure of equations and formulae, and don’t indent anything.
For example: x = [-b ± √(b2 – 4ac)]/2a

<Display>

We will then set this as:

x

b  b 2  4ac
2a

Alternatively, just handwrite the equations.
If you intend to set at least some of the mathematical content of your text, then
please format your text as follows:
Use italic for variables and algebraic constants, eg ax2 + bx + c = 0
This also holds for superscripts and subscripts, eg an = 1 for n = 1, 3, 5…
Use roman for labels and for: sin, cos, tan, lim, det, log, ln, e, i, Re, Im
Use bold italic for vectors, eg a × b = c
Please leave a single space either side of an operator such as + or ×.
Units are set in lowercase, even if they are based on someone’s name, eg watt,
kelvin, volt and their abbreviations are capitalised: 100 W, 273 K, 240 V. But note
the temperature unit ‘degree Celsius’ (°C) contains a capital letter — see BSI
(2013) Quantities and units, BS EN ISO 80000-1:2013 (page 26).
Please either use Insert > Symbol for multiplication signs and degree symbols or
use the keyboard shortcuts below. Don't use the letter 'x' or superscript 'o'.

Keyboard shortcuts
First make sure that NumLock on your numerical key pad is switched on. Then
holding down the Alt key, type the four-digit codes on the numerical key pad.
Raised decimal point
multiplication sign
division sign
minus sign (en dash)
degree symbol

·
×
÷
–
°

Alt 0183
Alt 0215
Alt 0247
Alt 0150
Alt 0176

[Back]
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Money, weights and measures
Money
The pound sign (£) and the pence sign (p) must never be used at the same time.
Use £0·84 or 84p — but keep to one style within a document.
There must always be two digits after the decimal point, unless there are no
pence, when the amount can be typed like this: £7.
This rule also applies to the euro and cent, the US dollar and cent, and all other
currencies.

Weights and measures
Insert a space between the number and the unit of measurement, eg:
 25 mm
 89 g

Percentages
Use either 25% or 25 per cent — but keep to one style within a document.
[Back]
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Nouns
Collective nouns
These words (eg Government, Scottish Enterprise, HM Inspectorate) sometimes
look as if they’re plural, but we use them as singular. So, for instance, you should
say:
‘the Government is doing this’ not ‘the Government are doing this’.
The same is true for ‘SQA’:
‘SQA is responsible for…’ not ‘SQA are responsible for…’
(though, of course, you can say ‘we are responsible for…’)

Nouns as adjectives
Please try not to use nouns as adjectives. In the phrase ‘candidate evidence
judgement record’, every word is a noun, as is every word in ‘school curriculum
unit information pack’.
At best, this sort of construction is unattractive. At worst, it can be confusing, or
even incomprehensible. This is because there are several possible ways for
readers to guess the meaning. Is a ‘candidate evidence judgement record’ a
record of candidates’ judgements about evidence, a record of judgements about
evidence of candidates, a record of judgements about candidates’ evidence, or a
record of evidence judgements about candidates? Are some, or all, of these the
same? It takes unnecessary time and effort to work this out.
The best thing to do is to try to work strings of nouns into grammatical forms. This
may involve using a couple of extra words here and there, but you will find that
the sense you want to convey comes across more clearly. The two examples we
gave earlier would be better given as: ‘a record of judgements of candidates’
evidence’ and ‘an information pack for schools on units in the curriculum’.
Similarly, try to avoid turning nouns into verbs, which can also be confusing. For
instance, instead of ‘mainstreaming e-assessment’, try ‘making e-assessment
mainstream’.
[Back]
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Numbers
The rules for giving numbers in non-science subjects are:
 The numbers one to nine should be written out in full, as they have been here
unless they are part of a series of numerical data. The numbers 10 and above
should be given as figures.
 Use figures in tables and equations.
 Always give exact amounts in figures — this applies to money, quantities, and
time, as well as to the credit value of a qualification, or its level.
 When using figures, insert commas: 1,300 or 103,000.
However, in science and maths subjects, use a thin space (6 pt) in place of a
comma separator in five digit numbers and above (eg 500 000).
 At the beginning of a sentence, always either write the number out in full,
even if it is greater than 10:
‘Results have shown improvement this year. Thirty-one candidates achieved
grade C.’
Or, recast the sentence. Recasting the sentence is the better option for numbers
which are greater than 100 — don’t write:
‘Thirty-one thousand six hundred and seven candidates achieved grade C’.
Write: ‘The number of candidates achieving grade C was 31,607’.
Note that compound numbers written out in text (thirty-one, sixty-seven, and so
on) should be hyphened.
To show a range of values, use a short dash (alt 0150),.
(3–15 curriculum, 100–150 candidates, etc). The keyboard shortcut for a short
dash is alt 0150. (You need to have Num Lock on.) Note that a short dash is
slightly longer than a hyphen, which has its own key.
NQ question papers use raised decimal points, eg: 37·4. You can insert a raised
decimal point by holding down the Alt key and typing 0183 (with Num Lock on).
[Back]
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Paragraphs
Like a section or a chapter, a paragraph is itself a small, self-contained unit. The
trick is to express an idea, develop it, and then round it off. You should also link
what you are saying with the idea being dealt with in the next paragraph.
A useful rule of thumb is that the ideal paragraph is five lines long and has three
sentences. The first sentence states an idea:
‘Some candidates may find the language we use difficult to understand.’
The second takes the idea a bit further:
‘We can, though, do a number of simple things to make their lives easier.’
The third rounds the idea off, and links to the next paragraph:
‘Using shorter words and sentences is an important first step.
There is often a tendency in education to use language that is far too
complicated…’
You won’t always be able to conform to this three-sentence rule — sometimes it
just isn’t possible and you will find you are using two sentences or four or five. If
you find, though, that your paragraphs are running to 10 lines or 15 lines, it may
be that you are trying to express too many thoughts and ideas in the one go.
Stop writing for a moment and try to find a way of breaking down what you are
trying to say into smaller chunks.
You may find it helpful to draw up the same sort of plan for your paragraphs in
each section as you did for the sections of the document. Imagine the section or
subsection you are writing as a story. Plan how to get from beginning to end, and
you will find that the steps you write down form, more or less, the basis of your
paragraph structure.
[Back]
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Phone numbers
Put a space between the area code (eg 0141, 0131) and the next three digits,
then another after those, eg 0141 278 1000, 0131 561 1000.
For mobile phone numbers, where there’s no area code as such, insert a space
after the first four or five digits to leave a group of six or seven to the right.
[Back]
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Photographs
If you are providing photographs for a document, please supply JPEG files at the
highest resolution your camera can work at.
Stock photography websites can be a good source of high-quality images. They
are particularly good for images of everyday items and situations. If you need this
kind of image for your publication, try browsing Shutterstock. You can collect
anything suitable into a ‘lightbox’ for later reference or click and drag low
resolution copies into a Word file. You need to register to use the lightbox facility.
[Back]
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Plain English
Plain English is about writing clearly and concisely with the reader in mind. It
allows you to say what you mean, in a way people will understand.
Using plain English is also part of promoting equality, because by writing in a
simple and straightforward way, we’re not (deliberately) excluding anyone. It
allows us to fulfil our duties to abide by equalities legislation.
Overall, plain English is an ideal way to demonstrate the ‘enabling’ and ‘trusted’
parts of our corporate values.

Use short sentences
Express one idea, simply, then stop. Don’t try to cram too many ideas in one
sentence. Break down what you have to say into smaller bits, and express each
bit as a separate sentence.
If you find that you are writing many sentences which contain more than 30
words, it is likely that readers are going to find them confusing.

Addressing readers
Make it clear who you are writing to in the subject line or introduction then
address your reader as ‘you’ throughout the text.
Don’t say…
‘Centres should retain candidates’ work for verification’
Do say…
‘You should retain candidates’ work for verification’.
If it’s something you wouldn’t consider saying in speech to your reader,
then don’t write it down.

Prefer active to passive
Try to mostly use an active construction, that is, one where A does B:
— ‘The teacher (A) spoke to the class (B).’
A passive construction is one in which B is done by A:
— ‘The class (B) was spoken to by the teacher (A).’
There are, of course, some things that are better expressed as passives, but
passives do de-personalise text and make it seem very remote from the reader.
The more passives there are in a text, the more this is reinforced. The effect this
has is to give readers the impression that we are bureaucratic and distant (which
is not the way we are at all).
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Don’t say…
Do say…
it has been decided we decided
it is recommended
we recommend
Similarly, avoid constructions like ‘centres are advised …’.
Find out how more about how to write in plain English from the Plain English
Campaign.
See our equalities web page
[Back]
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Planning and structure
Planning
The best sort of plan is a list of numbered points, following one another in a
logical order. It might help you if you think of what you have to say as a story.
Imagine yourself explaining whatever it is you’re writing about to an audience and
having to make them follow your line of thought.
The plan you make will probably form the basis of your sections when you come
to write. Here’s an example of a plan for a fictitious publication, the Teaching
Guide for the Group Award in Picture Framing:
1
2
3
4
5
6
7
8
9

Introduction: who the guide is for
An explanation of the units, their purpose and structure
What you will need to do the group award
What will happen when you do the group award
How to gather evidence
How to record evidence
What happens next
What you can do after you’ve done the qualification
More information/contacts

If you find you can’t write a plan like this, you’re probably not yet ready to write
your document. You will have to sit down and think again, or ask for advice.

Sections (or chapters)
Long documents should be divided into self-contained sections. You should use
each section to say everything you have to say about an aspect of your subject
matter. If you are writing a section on, for instance, assessment instruments,
don’t let what you have to say about assessment instruments spill over into your
section on verification.
By the same token, you mustn’t repeat chunks of text from one section in
another. It may well be, for instance, that what you’ve said in your portfoliobuilding section about the amount of evidence needed in a portfolio has a bearing
on internal verification, but that is no reason to quote it in full. Use a reference —
eg ‘see page xx’, or ‘see section 13, ‘Building a portfolio’’.

Subsections
Sections of a document can themselves be divided into subsections. For
instance, you might have a section on Core Skills in your guide for teachers for
Higher Latin, and each of the five Core Skills could have its own subsection.
It’s true that numbering subsections or paragraphs can be useful for referring
readers to particular bits of your document, but it also gives documents a very
bureaucratic feel. A better and friendlier way to enable readers to find their way to
the bit they want to look up, if they’re interested in recording evidence, for
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instance, is to have a subheading saying ‘recording evidence’ and a listing on the
contents page.
Don’t number your paragraphs or subsections like this:
1
1.1
1.2 etc
unless it is in, for example, a committee paper, or an agenda.
For more information on headings and styles in Word documents, please see
‘Guidelines for producing your publication’ on Connections.

Reading what you are writing
Almost as important as having a plan is reading what you have written. Once you
have started, go back as often as you like and look at what you have said.
Particularly, look for places where you have repeated yourself, or where you have
contradicted yourself.
If you have a clear idea of what you have already said, you will minimise the risk
of getting yourself confused. This will save editing time, and help you keep down
the number of words you use.
If you need advice on planning and structuring a particular document, contact
SQA’s editors via marketing@sqa.org.uk.
[Back]
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Quotation marks
Always use single quotes (’) when citing speech or quoting from a text. Double
quotes (“) can only be used for quotes within quotes, like this:
‘So I said to him, “What do you think you’re doing?” and I meant it, I can tell you.’
You are unlikely to need to use this sort of construction often when writing for
SQA.
[Back]
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Quoting from other documents
When you’re referring to an SQA publication for the first time in a document, give
its publication code and date, as in the example. After that, you can just give its
title, as in the next sentence. Never lift chunks out of the other publication and
repeat them in your document — use a reference, eg ‘see Guide to Assessment,
page xx’.
The main reason for not quoting large chunks of text from other publications is
that the publication you are quoting from may be out of date long before the one
you are writing.
In a situation where you don’t think your reader will have access to the document
there is overlap with, you can quote very short passages (say no more than two
sentences), or paraphrase its arguments, but please keep this to a minimum.
See also Referencing
[Back]
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Referencing
You should provide a list of references to books, journals, and websites
mentioned in your text to help your readers identify and locate them. You can do
this in footnotes, or a bibliography — try to keep your text as uncluttered as
possible.

Harvard referencing
SQA uses the Harvard (author, date) system.
In the main text
Give the author’s surname, the year of publication, and possibly a page reference
in the text, and then list the full reference at the end of your document. For
example, a citation in the text might look like:
‘Disciplinary procedures should be in writing’ (Hannagan, 2012, p302).
or
‘Hannagan (2012) says that disciplinary procedures should be in writing.’
In the bibliography
For a book, the reference in a bibliography would then appear as:
<author’s surname>, <initials> (year of publication), <title>, <edition (if not the
first)>, <place of publication: publisher>, <page number (if relevant)>
For example:
‘Hannagan, T. (2012) Management Concepts and Practices, 3rd ed, Harlow:
Prentice Hall, p39’
A journal article should appear as:
<surname>, <initials> (year of publication) <title of article>, <journal title>,
<volume> (issue), <page numbers>
For example:
‘Evans, W.A. (1994) ‘Approaches to intelligent information retrieval’, Information
Processing and Management, 7 (2), 147–168’
An internet reference should appear as:
<*author's/editor's surname>, <initials> (year) <article title>, <place of publication:
publisher>. Available from: <URL>
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*Note that the author may be an organisation, and place/publisher may not
always be ascertainable — provide as much detail as possible. It is also best
practice to add [date last accessed] but we will not use this in final publications.
Links to websites can be short-lived, so check that any web links are current at
the time of writing. Make sure that any web addresses in your document are
converted to working hyperlinks.
For example:
‘Academic Services, (2007) BU guide to citation in the Harvard style: brief guide,
Poole: Bournemouth University. Available from:
https://www1.bournemouth.ac.uk/discover/library/using-library/how-guides/howcite-references [accessed 25 April 2016]’
[Back]
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Referring to SQA’s qualifications
When you’re talking about SQA’s ‘product’, use ‘qualifications’. Don’t use ‘award’,
as this is used to refer to the grade a candidate achieves, eg A or B or pass. Only
use ‘award’ when referring to the specific qualifications called awards (such as
the Safe Road User Award). Use ‘group award’ when referring to SVQs, HNCs,
etc.
SQA has three families of qualifications: National Qualifications, Higher National
Qualifications, and Scottish Vocational Qualifications. Always use ‘family’ to
describe these (not ‘block’, for instance).
If you are giving a qualification a number as well as a name, give the number
first, then the title:
D321 12: Mathematics 1 (Higher)
Give the name in italics, and use initial capitals (title case), as in the example.

Capitals in the name of a qualification
Use initial capitals for the names of qualifications, but don’t capitalise words like
‘and’ or ‘for’.












National Qualifications
National Progression Awards
National Certificates
National 4 and National 5
Higher
Advanced Higher
Higher National Diploma
Higher National Certificate
Higher National Qualifications
Scottish Vocational Qualifications
Skills for Work

But note:





National courses
National units
Higher National unit
Higher National group award

Also, because units can be qualifications in their own right, use ‘Unit’ in the unit
name, eg Historical Study: British (Higher) Unit.

Level of a qualification
When you’re talking about the level of a qualification — whether it’s the SQA level
or its level in the SCQF — the word ‘level’ doesn’t need a capital (unless it’s at
the beginning of a sentence, of course).
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We now describe all our qualifications by giving their SCQF level.
From September 2016, names of SVQs (if they have an SCQF level) should use
the following convention:
SVQ <name> at SCQF level <x>
For example:
SVQ Activity Leadership at SCQF level 5

Grades
We use ‘grade’ with a lower-case ‘g’ to mean the level of award made to a
candidate.
Where qualifications have numeric levels, or can be awarded at numeric grades,
always give these in Arabic numerals (1, 2, 3, etc), ie not Roman I, II, III, etc.
Grades at Higher and Advanced Higher are given letters. These are always
written as capitals, ie A, B, C.
[Back]
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Repetition
Repetition is a problem in two ways:
Redundancy: we have a tendency to try to tell our readers the whole story all the
time. We will, for instance, tell them about verification, which makes us feel we
have to tell them about the whole quality assurance system. This in turn makes
us want to explain the approval criteria, even if we have already done so. If
you’ve explained internal verification once, there’s no need to explain it again —
use a cross-reference.
Stylistically: a simple style check you can do before handing over your finished
copy is to read over what you have written to see whether there are certain
phrases or words you have overused. Just looking at a printed page often helps
you see at a glance whether there’s anything obvious you’ve repeated.
If, for instance, you’ve started four consecutive sentences with ‘SQA’, the text
would read better if you changed at least two of these.
Similarly, if you’re presenting a list of options which are expressed in similar
language, try to vary them. If bullet points start with the same word or phrase,
move this back behind the colon introducing the list. Not:
‘In addition, many people have found that:





National units are great
National units are brilliant
National units are flexible
National units are very good indeed’

But:
‘In addition, many people have found that National units are:





great
brilliant
flexible
very good indeed’

[Back]
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Should and must
‘Should’ means a recommendation, or a piece of advice. ‘You should listen to
what this guide is saying’ is not an order, but a way of urging you to take note.
‘Must’, on the other hand, means compulsion, and the lack of alternatives, as in
‘you must signal your intention to pull out before manoeuvring away from the
kerb’.
You must not be afraid of using ‘must’, if it is appropriate to do so. If, for instance,
people in centres have to submit results using a certain form, tell them so. ‘You
must use form 1 for submitting results.’ Don’t feel that you have to use ‘should’,
simply because it seems politer — it could cause confusion.
[Back]
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Spelling checklist
This is an alphabetical list of words we use a lot, and some special features they
have — it may be that they’re often mis-spelled, or that they can be confused with
something very similar. See SQA’s Guide to Using Capital Letters on
Connections for rules about when we should and should not use an initial capital.
Write the word like this …

… and note that it’s

adviser

not advisor (though some SVQ standards-setting
bodies use the -or spelling)

benefit

benefiting, benefited (don’t double the ‘t’)

centre-devised

always hyphened

closed-book

hyphened when you’re talking about a kind of
assessment (another kind is open-book)

competence

not ‘competency’; competences in the plural (not
competencies)

convener

(ends in ‘-er’) for someone chairing an SQA
meeting, but some local authorities use ‘convenor’
for council leader

conducive

not condusive

consensus

not concensus

criteria

the plural of ‘criterion’

Curriculum for Excellence

without an ‘a’ or ‘the’ prefix, and should be written
out in full in formal documents (not ‘CfE’)

e-assessment

‘E-assessment’ at the start of a sentence

e-commerce

‘E-commerce’ at the start of a sentence

e-business

‘E-business’ at the start of a sentence

e-mail

not ‘email’. E-mail at the start of a sentence

end-user

hyphened

enrol

enrolling, enrolled, enrolment (but use ‘entry’ for
candidates)

focus

focusing, focused (don’t double the ‘s’)
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forum

forums in the plural, except when talking about
Roman architectural features, when you can use
fora

Gàidhlig

Gaelic for Gaelic — use alt 0224 on your keyboard’s
number pad to get the à (NumLock must be on)

helpdesk

all one word

internally-assessed

hyphened when it comes before ‘units’, eg
internally-assessed Units; not hyphened when it
comes after a verb, eg these Units are internally
assessed

licence

with a ‘c’ for the noun, eg driving licence, but with an
‘s’ for the verb, eg licensing laws

nationally-devised

always hyphened

centre-devised

always hyphened

nationally-recognised

always hyphened

consortium-developed

always hyphened, and never ‘consortia-developed’

ongoing

not hyphened

online

one word, no hyphen — ‘offline’ should be written
the same way

per cent

not ‘percent’

phone

not necessary to write ’phone

practice

with a ‘c’ for the noun, eg ‘piano practice’, but with
an ‘s’ for the verb, eg ‘practising the piano’

pro forma

two words, no hyphen

re-assessment

lower case

standards-setting body

all lower case, and hyphened

subject-specific

always hyphened

SQA co-ordinator

lower case, except when the title of a particular
individual

target

targeting, targeted (don’t double the ‘t’)
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timescale

one word, no hyphen

up to date

without hyphens except when preceding a noun, eg
‘the qualification is up to date’, but ‘the up-to-date
qualification’

web page

two words

website

one word, no hyphen

www.sqa.org.uk

our URL (website address) — always hyperlink; if
it’s at the end of a sentence, put the full stop in

[Back]
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Titles of people involved with qualifications
Positions or roles of SQA employees and appointees are set in title case when
referring to individuals, but use lower case when referring to positions or roles in
general. Here are some examples:
‘Sam Smith, Qualifications Manager, was recently appointed to the …’
but
‘SQA qualifications officers are responsible to a qualifications manager.’
‘Overall, external verifiers found that the centres sampled had a clear
understanding of the requirements for …’
‘A nominee represents their school/college and local authority (where
appropriate) in assisting SQA with the maintenance of national standards of the
qualifications within their subject area.’

Referring to the people who take our qualifications
The people who are taking our qualifications are ‘candidates’, but only when
they’re taking the qualifications, eg in the exam hall, or being assessed in their
workplaces. You’ll use the word ‘candidate’ most often when you’re talking about
assessment or certification.
At all other times, you can refer to these people as ‘learners’ if they are at school
or college and ‘trainees’ if they’re doing workplace training. ‘Students’ is a
suitable alternative for learners at college. It’s also fine to talk about more specific
roles (apprentices, trainee hairdressers, fitters, etc) if your document is very
specific.

The process of entering candidates for qualifications
Candidates are ‘registered’ only once and are subsequently ‘entered’ for
‘qualifications’. Usually, they will go on to receive an ‘award’ in a qualification.
SQA ‘charges’ centres for entries. We pay ‘fees’ to appointees.
The places (schools, colleges, workplaces, etc) where candidates do the
qualifications are called ‘centres’. We no longer use the term ‘presenting centres’.
[Back]
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That or which?
This is a source of confusion, and there’s no hard and fast rule. It helps your
reader, though, if you use ‘that’ to introduce a defining clause:
‘The dogs that barked in the night did not recognise the thief.’
And use ‘which’ to introduce a describing clause:
‘The dogs, which barked in the night, did not recognise the thief.’
In the first example, ‘The dogs that barked’ suggests there were other dogs that
did not bark. In the second, we can be more confident that all the dogs barked
(and the comma between ‘dogs’ and ‘which’ helps). If you use ‘that’ and ‘which’ in
this way you can help your reader work out whether or not all the dogs barked.
A good rule of thumb is that, if you’re in any doubt about whether to use ‘that’ or
‘which’, you should use ‘that’. However, when writing about a person or people,
you should always use ‘who’.
[Back]
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Templates
SQA’s standard Word template is called ‘SQA Normal’. We recommend that you
use it for most types of document other than letters.
Follow the instructions on the next page to set up a link between the My
Templates folder on your machine and the templates folders on SQA’s network.

Once you’ve done that, click File > New > My Templates to open a new
document in SQA Normal. Alternatively, click on the General tab for other
templates such as the letter template.
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How to connect to SQA’s templates
In Word, click File in the top menu and select Options. The Word Options
dialog box opens.

Click on Advanced then scroll down to near the foot of the new list of options and
click on File Locations.
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In the File Locations dialog box, click on the Workgroup templates entry, then
click the Modify button.

You should modify the entry to be one of the following (depending on your site):
\\sqa3-hanover\templates
\\sqa4-dalkeith\templates
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Do this by clicking in the file location bar at the top of the dialog box and keying-in
one or other of the above paths. The dialog box will then change to look like this:

\\sqa3-hanover\templates was
keyed here

Finally, click OK until all the dialog boxes are closed.

Now when you click File > New then click on the My templates button you will
be presented with a list of SQA templates to choose from under the General tab.

[Back]
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Tone
How to address readers
Often when we write to people we are assisting them to achieve a goal,
which could range from completing a form, to writing an assessment, or
quality-assuring a centre.
It is therefore important that your writing is clear, concise and inclusive.

Be clear
Don’t write in a manner that is impersonal and passive. It makes us seem
bureaucratic and remote from the concerns of our readers.
Try to address your readers personally. Your text will be easier to
understand and less intimidating.
As an example, consider the first sentence in that last paragraph. There
are other ways of expressing this idea. Here’s a list, in increasing degrees
of remoteness:


You should always try to address the reader personally.







It is better to address the reader personally.
Writers should address readers personally.
The writer should address the reader personally.
Readers should be addressed personally.
Reader address should be personal in tone.

There’s sometimes a tendency for the tone of writing which deals with
educational or organisational subjects to be pitched at or around the
bottom end of this list, in remote and formal language, but there’s really no
need for this to be so. As a guideline, bear this in mind: if it’s something
you wouldn’t consider saying in speech, don’t write it down.
You can even use this approach for procedural documents which are
written for people in centres who are doing the organising and
administration which running our qualifications demands. Once you’ve
made this plain in an introduction, there is no reason why you shouldn’t
then address these people as ‘you’ throughout the text, rather than
referring to ‘centres’. So, don’t say: ‘Centres should retain candidates’
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work for verification’, if it would be just as easy to say: ‘You should retain
candidates’ work for verification’.
Similarly, a lot of what we write is written for teachers and tutors. If you’re
writing for teachers and tutors, say so and then address them personally
— call them ‘you’, not ‘teachers/tutors’. They may pay more attention to
what you have to say, and will find it easier to understand.

Be concise
Use simple and direct language. Avoid unnecessary words.

Be human
Your writing needs to convey meaning to everyone who needs to act on it
so that they then respond in the way that you intended. So avoid words or
phrases that might confuse or even antagonise your audience and choose
words and phrases that show you are one person communicating with
another. Some SQA writing reads as if we are lecturing a group, but even
if you are broadcasting a message to a wide audience it can help to write
as if you are ‘talking’ to an individual.
These ideas are not new. Over 60 years ago, the Civil Service
summarised these rules as: ‘Be short, be simple, be human.’
See Gowers, Sir EG (1954) The Complete Plain Words, London: HMSO
[Back]
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Web pages
People don’t read text on a website in the way that they read printed material.
They scan, rather than scrutinise. They pick out headings and key words, rather
than read everything chronologically and line-by-line. They also tend to spend
less time reading online than they would reading print.
Also, because of the nature of the internet, the order in which we present
information on the site may not be the same order in which it is read by the user.
They may jump to a specific location within the site from a link or search result,
and so not have the background knowledge of the preceding pages.
So when producing information for online publication, the first thing you need to
ask is: what is the most appropriate way to display your information? Would it be
better for the reader if it was:
 a single web page or series of web pages forming a section of the website
 a separate stand-alone website
 an interactive application
 a file that users can download or print and read at their leisure?

General tips and best practice
All web pages should be self-contained and self-explanatory. If a reader lands on
a page with no knowledge of the preceding pages, they should still be able to
make sense of the information provided.
 Use plain English and keep specialised terminology to a minimum. If
someone has to re-read a sentence or phrase to clarify the meaning, then the
text is not fit for purpose.
 Use headings and subheadings that provide information to your reader.
 Aim to have one key idea per paragraph. Structure paragraphs so that the
conclusion or key idea is given in the first sentence and then provide more
detail in the sentences that follow.
 Keep text to a minimum.
 Use bulleted lists to break up the information so that readers can easily find
what they are looking for.
 Information should be appropriately introduced and titled to explain the
context. It’s not enough to provide a link or document titled, for example,
‘SQA workshop presentation’ — as it could be referring to any workshop that
has been held by SQA.

See the Web Team community on Connections for more
[Back]
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Wikipedia
Wikipedia is a popular source partly because the content is free to use — but
there are conditions that need to be adhered to. See:
https://en.wikipedia.org/wiki/Wikipedia:Copyrights#Reusers.27_rights_and_obliga
tions
[Back]

67

Word — readability statistics
Flesch readability statistics are based on the average sentence length, the
number of difficult words, the number of passive sentences, and paragraph
length.
You can take your checking a bit further with a little application that will tell you
how readable your writing is. Go to File > Options > Proofing and make sure that
the ‘Show readability statistics’ option is ticked.

Then the next time you run the spellchecker, a window like the following will
appear:
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You can ignore the Flesch-Kincaid Grade Level, which is based on the reading
ages attained in US school grades. The important figure is above this. The higher
the figure (it’s a percentage), the better. You should be aiming for 40 and over for
an audience of teachers, 50 and over for the general public, and 60 or over for
learners. If your score is low, you can use the information under ‘Averages’ to
improve it.
[Back]

69

Word — spellcheck
Always use the spellchecker, though you’ll have to decide whether the
suggestion offered is indeed correct. Remember we use ‘organise’ not ‘organize’.
Before you use the spellchecker, please make sure that your document’s
language is set as UK English (go to File > Options > Language).

Caution!
Word’s checking tools cannot catch words that are spelled correctly but
which don’t make sense.
[Back]

70

Words we prefer to use
How many words should I write?
If there is one basic principle for writing clearly, it is this: keep it short and simple.
This applies across the board to words, sentences, paragraphs, chapters, and,
especially, to documents. Say what you want to say in as few words as you can,
then say no more — saying more tends to confuse the issue.

What’s a good word to use?
This is a difficult question to answer in detail. We can’t give you a list of words to
choose from and say ‘don’t use any others’, because the words you use will
depend on your subject matter, and how comprehensibly you are using them
depends on their context. In general, though, good words are plain, simple and
easy to understand.
You have a degree of freedom to choose whether to use only short words or
mainly short words but a few big ones, depending on your audience. If you’re
writing for candidates with learning difficulties, for instance, the words (and
sentences, and paragraphs) you use must be as simple as possible. If you’re
writing for college staff or schoolteachers, you can use more complex
constructions. The important thing is to be as direct and unambiguous as
possible. Everyone would rather have a simple text to read than a difficult one.

What’s a bad word?
Any word is bad if people aren’t going to understand what you’re trying to say
with it. There is, for instance, little point in using a word like ‘architectonic’ in a
piece of writing, because no-one reading it will know what you mean. Similarly,
it’s all very well knowing what ‘lugubrious’ means, but are you using it just to
show off? Why not use ‘sad’ or ‘mournful’ instead?
Try to avoid using big words derived from Latin (words ending in ‘-tion’, ‘-ment’ or
‘-ise’ for instance) if you can think of a simpler way of saying what you want to
say. So, if you can say ‘help’ instead of ‘contribution’; or ‘carry out’ rather than
‘implement’, do so.
A guideline: the more syllables there are in a word, the more reluctant you should
be to use it.

Words to think twice about before using
Many newspapers and publishers have ‘hate lists’ of words which are so
overused that they would appear in every single story unless the paper took
drastic action to prevent it. A paper will ban these words from ever appearing in
print. Read The Sunday Times and see if you can spot an occurrence of the
words ‘major’ or ‘current’. There should be very few in this paper. ‘Very’ can also
be used unnecessarily.
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We are not banning the words in this list. We are saying please try not to use
them as they are a) hugely overused, and b) often a sign of sloppy thinking or
writing.
a number of: This is a vague, woolly, and bureaucratic phrase. Don’t use it —
say ‘some’ instead. If you absolutely must use it, remember that it takes a plural
verb, not a singular — ‘a number of people are concerned’ not ‘a number of
people is concerned’.
appropriate: This word often means nothing, as in the phrase ‘SQA staff will give
the appropriate advice and guidance’. If you say we will give people ‘appropriate
advice’, does this mean that they sometimes get inappropriate advice from us, or
that they think they might? Instead of using the word, either say what the
appropriate advice might be, or miss out the word altogether.
articulate: This really means ‘to say’, but is sometimes used to mean ‘to lead on
to’, or ‘to progress’. Please use the simpler alternatives.
associated: should never be used as an adjective. The phrase ‘this performance
criterion and its associated evidence requirements’, for instance, is confusing
because you wonder which evidence requirements for the performance criterion
are the associated ones, and which are not.
at this point in time and its cousin at this moment in time are voguish in some
circles, but raise most people’s hackles. Don’t use them.
implementation: We use this word to mean ‘setting up’ qualifications so that they
can be delivered or ‘putting them into practice’ so that candidates can take them.
Don’t use ‘implementation’ to mean teaching, training or assessment.
in relation to: This crops up all the time in phrases like ‘SQA’s policy in relation
to …’. You should always be able to replace it with ‘on’ or ‘about’, or to miss it out
altogether.
indicate: can sometimes be replaced by ‘show’.
inform: can almost always be replaced by ‘tell’.
particular and specific: These are very widely used, but very rarely mean
anything. If you feel a temptation to use either of them, read your sentence over
and ask yourself what ‘particular’ means in ‘the particular candidate’. Nine times
out of 10 you will be able to dispense with it altogether. The same goes for
‘specific’. This may seem like quibbling, but, as we’ve said before, using words
which add nothing to the meaning of a phrase makes that phrase harder to
understand.
relevant: One of the most overused words in our vocabulary. In a phrase like
‘after consultation with relevant staff’, what meaning does the word add? Do
people regularly consult with irrelevant staff?
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within: means ‘inside’. Don’t use ‘within’ if you mean ‘in’. You almost always
mean ‘in’. There is no meaningful sense in which anything can be ‘within’ a
qualification, or ‘within’ a context. You can, though, be within a building, and
things can happen within an organisation (if they happen exclusively inside it).

General ‘think twice’ list
This think twice list applies more generally than to our publications. It’s based on
Plain English Campaign guidelines for, well, plain English.
Try not to write:

Instead, write:

assist

help

therefore

so

prior to

before

until such time as

until

consequently

then

as indicated above

as we’ve already said, or see the section on ...

as itemised below

here is a list

as mentioned previously

as we’ve already said

as regards/with regard to

about

in relation to

about, of

for the purposes of

for

in order to

to

within (unless you mean
‘inside’)

in

additional

more

further

more

have responsibility for

be in charge of, deal with

by means of

by

consist of

be made up of
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constitutes

is, makes, builds up to

effect (as verb)

make, do

facilitate

help

function

role, work, job

in accordance with

under, following

in addition

also, as well

in conjunction with

with

legislation

law, laws

necessitate

cause

obtain

get

proficiency

skill

capability

ability

regarding

about, on, to, of

relating to

about, on, to, of

require to

need to, have to

sufficient

enough

terminate

end, stop, finish

undertake

do, try for

utilise

use

with reference to

about

[Back]
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Writing about people
When you’re speaking about people other than your readers (whom you should
always address as ‘you’), speak about them in the plural. This will apply, for
instance, when you’re speaking about candidates in a guide for teachers and
tutors.
There are two reasons for this. If you speak about them in the singular, you will
find yourself using phrases like ‘the candidate can progress to other
qualifications’, which is objective and de-personalised, and makes the candidate
sound like a thing rather than a person. Also, you will get into trouble when you’re
using pronouns and find that you are having to say ‘he or she’ all the time. Using
the plural gets around this because you can use the neutral ‘they’.
It’s not really wrong to use ‘they’ for a single person (eg to say ‘if a candidate is ill,
they might be eligible for special consideration’), but some people are
uncomfortable writing (or reading) this kind of construction. If you’re one of them,
don’t use it. Don’t, however, worry about it, as worrying about this kind of thing
gets in the way of clear expression.
[Back]
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Writing the name of the organisation

If your document has the above logo you can refer to ‘SQA’ in the text.
Elsewhere, though, give the name in full when you first use it. After this, you can
say ‘SQA’. Don’t use ‘the Authority’, as it can be confused with ‘education
authority’, and might be taken as pompous.
When giving the name in its abbreviated form, use ‘SQA’ not ‘the SQA’.
[Back]
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